
Contents

Introduction:
What is Gold-Fax? 
How Gold-Fax Works 

Gold-Fax Help Topics:
Introduction to Gold-Fax Phonebooks 

Opening a Phonebook 
Creating a New Phonebook 
Adding a Name to a Phonebook 
Editing a Phonebook Name 
Viewing a Phonebook Name 
Deleting a Phonebook Name 
Copying or Moving a Phonebook Name 
Searching a Phonebook 
Printing a Phonebook 

Introduction to Gold-Fax Distribution Lists 
Creating a Distribution List 
Modifying a Distribution List 
Deleting a Distribution List 

Introduction to Gold-Fax Preferences 
Changing Default Preferences 

Creating and Sending Faxes 
Creating a Fax Message from the Gold-Fax Text Editor 

Including Graphics in a Fax Message 
Creating a Fax Message from Another Windows Application 
Specifying Fax Recipients 
Sending the Fax to Phonebook Entries 
Sending the Fax to a Distribution List 
Entering a New Fax Recipient 
Changing Addressee Information 
Removing a Fax Addressee Entry 
Sending a Fax 
Resending a Fax 
Viewing a Sent Fax 

Introduction to Sent Faxes 
Displaying the Sent Fax Status Index 
Printing Status Information 
Refreshing a Status Index 
Stopping a Fax in Progress 
Deleting a Sent Fax Status Entry 
Resending a Previously Sent Fax 
Viewing a Sent Fax 



Introduction to Received Faxes 
Viewing a Received Fax 
Editing Received Fax Information 
Copying or Moving a Received Fax 
Forwarding a Received Fax 
Forwarding a Received Fax Through Microsoft Mail 
Deleting a Received Fax 
Printing a Received Fax 
Automatically Forwarding Received Faxes 

Routing Received Faxes 
Forwarding Unrouted Faxes 
Editing Unrouted Faxes 
Printing Unrouted Faxes 

Introduction to Gold-Fax Folders 
Opening a Folder 
Creating a New Folder 
Deleting a Folder 
Finding a Folder 

Introduction to the Gold-Fax Viewer 
Opening the Gold-Fax Viewer 
Viewer Toolbar Options 
The PageBoard 
View Menu Options 
Scale Menu Options 
Forwarding Faxes Through Microsoft Mail 

Returning to Gold-Fax from the Viewer 



What is Gold-Fax?

Use Gold-Fax to fax word processing documents, spreadsheets, and other types of files directly from client 
systems running Microsoft Windows 3.1, Windows 95, and Windows NT.
Send fax messages directly from Gold-Fax using the Gold-Fax text editor, or from other Windows applications 
with commands that are similar to those you currently use to print documents and files.    Fax messages can 
include both text and graphics.
Gold-Fax phonebooks store frequently-used fax numbers, and Gold-Fax distribution lists automate sending faxes 
to a group of recipients.    Faxes can also be sent to names and numbers that are for the current transmission 
only.
The Gold-Fax Viewer allows you to view, rotate, scale, and forward sent and received faxes.
(Note: Viewing of sent faxes is supported only when running Gold-Fax with a Gold-Fax Windows NT server 
system.)
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How Gold-Fax Works

Q: How are Gold-Fax messages created?
A: Fax messages can come from the documents and files produced by applications you are using now.    These 

messages are sent using commands similar to those you are using to print your documents and files.
Text messages can be created and sent directly from Gold-Fax using the Gold-Fax text editor.    External 
graphics files can be included within the message using a special graphics keyword.

Q: How are Gold-Fax recipients designated?
A: The names and numbers of fax recipients can be stored in your own personal phonebooks.    You can also 

use names from company-wide or departmental phonebooks that are stored on the Gold-Fax Server.    Fax 
names and numbers can also be entered for the current fax message only.

Q: How are Gold-Fax messages sent?
A: Your fax print request is forwarded to Gold-Fax printers on the Gold-Fax Server system.    Gold-Fax printers 

convert your files to Group 3 fax format, call the designated fax phone number(s), and send the fax using a 
fax modem.

Q: How do I know if my fax was successfully sent?
A: Gold-Fax can send you an electronic mail message notifying you if the transmission was successful or if it 

failed.    You can also review and print the status of all fax messages sent within a period specified by your 
system manager.

Q: How do I receive faxes?
A: With the appropriate modem equipment and phone lines, it is possible to have received faxes automatically 

routed directly to your desktop.    Another method is to have a user who is a Gold-Fax router view the first 
page of the fax (usually the cover page) to determine the recipient and forward your faxes to you.
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Introduction to Gold-Fax Phonebooks

Use Gold-Fax personal phonebooks to store names, numbers, and other information for frequently-used fax 
recipients.    Gold-Fax system phonebooks are maintained on the Gold-Fax Server and allow you to access names 
from company-wide or departmental phonebooks.
The phonebook file "personal.gfp" is automatically created in your installation directory when you install Gold-
Fax.    You can create other phonebooks with the New Phonebook option from the File menu.    The default file 
extension for phonebook files is ".gfp."
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Opening a Phonebook

1. Choose the Open Personal Phonebook or Open System Phonebook button on the Main Gold-Fax toolbar:

or, from the Gold-Fax File menu, choose Phonebook, then choose either Open Personal... or Open System....    
The Gold-Fax: Open Phonebook dialog box displays.

2. Select or enter an existing phonebook file name.
For Windows NT users: Choose the Network... button to connect to another network drive and access other 
phonebook files.

3. Choose the OK button to open the selected phonebook.
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Creating a New Phonebook

1. From the Gold-Fax File menu, choose Phonebook, then choose New Personal.    (Depending on your site's Gold-
Fax setup, you may also be able to create and maintain system phonebooks.    See your system manager for 
more information regarding your site's Gold-Fax setup.)    The Gold-Fax: Create Phonebook dialog box 
displays.

2. Enter a new phonebook file name.    (The default file extension for phonebook files is ".gfp.")
For Windows NT users: Choose the Network... button to connect to another network drive and create your 
phonebook on that drive.

3. Choose the OK button to open the phonebook.
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Adding a Name to a Phonebook

1. Open the Gold-Fax Phonebook to which you want to add a name.
2. Choose the Add button on the Phonebook toolbar:

or, from the Name menu, choose Add.    The Gold-Fax: Add Phonebook Name dialog box displays:

3. Enter phonebook information in the following fields:
Name
The reference name for this phonebook entry, limited to 15 characters in length.    The Name must begin with 
a letter, and it cannot contain commas (,) or slashes (/).
Fax #
The fax phone number for the company or person.
To
The name of the recipient.
Company
The company name of the recipient.
Address
The address for the company or person.
Voice #
The voice phone number of the company or person.
Comment
Additional information you may want to remember for this name.

4. When you have entered all of the phonebook fields, choose the OK button to add the entry to the phonebook. 
Choose the Cancel button to exit the dialog box without adding the entry.
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Editing a Phonebook Name

1. Open the Gold-Fax Phonebook containing the name you want to edit.
2. Double-click on the name to edit, or select the name and choose the Edit button on the Phonebook toolbar:

or, from the Name menu, choose Edit.    The Gold-Fax: Edit Phonebook Name dialog box displays the 
information for that name.

3. Make any desired changes to the phonebook name.    Note that the "Name:" field cannot be edited.    To 
change the Name, choose the Save As... button and save the entry to a different name.    You can then delete 
the old entry.

4. Once you have made changes, choose the OK button or the Save As.... button.    OK saves the changes to the 
existing name;    Save As... allows you to save the changes to a new name.    Choose the Cancel button to exit 
the dialog box without saving changes.
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Viewing a Phonebook Name

1. Open the Gold-Fax Phonebook containing the name you want to view.
2. Select the name to view.
3. Choose the View button on the Phonebook toolbar:

or, from the Name menu, choose View.    The Gold-Fax: View Phonebook Name dialog box displays the 
information for that name.

4. Choose the OK button to return to the open phonebook.
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Deleting a Phonebook Name

1. Open the Gold-Fax Phonebook containing the name you want to delete.
2. Select the name to delete.
3. Choose the Delete button on the Phonebook toolbar:

or, from the Name menu, choose Delete.    The Gold-Fax: Delete Phonebook Name dialog box displays the 
information for that name.

4. Choose the Yes button to delete the name, or choose the No button to leave the name in the phonebook.
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Copying or Moving a Phonebook Name

Phonebook entries can be copied or moved between phonebooks.    With Copy, a copy of the phonebook entry 
remains in the original phonebook; with Move, the entry is deleted from the original phonebook.
To copy or move a name:
1. Choose the Open Personal Phonebook or Open System Phonebook button on the Main Gold-Fax toolbar (as 

desired):

or, from the Gold-Fax File menu, choose Phonebook, then choose either Open Personal... or Open System....
Note: Phonebook entries can be either copied or moved from personal phonebooks.    Depending on your 
Gold-Fax system setup, you may be able to only copy (not move) entries from system phonebooks.    See your 
system manager for more information regarding your site's system phonebook access.

2. Select or enter the name of the phonebook file containing the name you want to copy or move and choose 
the OK button.

3. Select the name(s) to be copied or moved.    Use the Shift key to select all names between two points; use the
Control key to select multiple non-sequential names.

4. Choose either the Copy or the Move button on the Phonebook toolbar:

or, from the Name menu, choose either Copy or Move.
5. From the Gold-Fax: Copy/Move Phonebook Name dialog box, select or enter the phonebook file name to 

where the entry is to be copied or moved and choose the OK button.
For Windows NT users: Choose the Network... button to connect to another network drive and access other 
phonebook files.
Choose the Cancel button to exit the dialog box without copying or moving the name.
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Searching a Phonebook

The Search function allows you to search the open phonebook for entries containing specific criteria.
To search phonebook entries:
1. Open the Gold-Fax Phonebook you want to search.
2. Choose the Search button on the Phonebook toolbar:

or, from the Name menu, choose Search.    The Gold-Fax: Phonebook Search dialog box displays:

3. Enter the desired search criteria in the following fields:
Find What
Specify the information to find.    All entries containing the specified characters will be found.
Match Case
Select this checkbox to search for entries with the same capitalization as the text entered in the "Find What" 
field.    (Only available when searching the "To," "Company," and "Address" fields.)
Phonebook Field
Open this list box to specify the phonebook field to search.
Find Next
Begin the search or find the next entry matching the specified search criteria.
Cancel
Cancel the search and exit the dialog box.
Direction
Specify the direction to search.

4. Choose the Cancel button to end the search and return to the open phonebook.
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Printing a Phonebook

1. Choose the Open Personal Phonebook or Open System Phonebook button on the Main Gold-Fax toolbar:

or, from the Gold-Fax File menu, choose Phonebook, then choose either Open Personal... or Open System....
2. From the displayed list of phonebooks, select or enter the file name of the phonebook you want to print.
3. Choose the OK button to open the selected phonebook.
4. Choose the Print button on the Main Gold-Fax toolbar:

or, from the Gold-Fax File menu, choose Print.
5. Set print values within the Print dialog box.    Choose the Setup button to select another printer.
6. Choose the OK button to print the phonebook or choose the Cancel button to exit the dialog box without 

printing the phonebook.
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Introduction to Gold-Fax Distribution Lists

Gold-Fax distribution lists allow you to send fax messages to a list of phonebook names.    Distribution lists can 
include individual phonebook names and can also reference other distribution lists.
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Creating a Distribution List

1. From the Gold-Fax File menu, choose Distribution Lists, then choose Create...    The Gold-Fax: Create 
Distribution List dialog box displays.

2. Enter the name for the distribution list.    (The default file extension for distribution lists is ".dis.")
For Windows NT users: Choose the Network... button to connect to another network drive to access other 
distribution list files.

3. Choose the OK button.    The Gold-Fax: Create Distribution List dialog box displays:

4. Your default personal phonebook is automatically opened with its entries listed.    Use the phonebook selection
box in the lower left corner if you want to add names from a different personal or system phonebook file.

5. To add names to the distribution list, select the name and choose the RIGHTARROW button.    (You can also 
add names by double-clicking on the entry.)

6. To reference another list within this distribution list, choose the Add List button to display the Gold-Fax: 
Open Distribution Lists dialog box.
Select the desired distribution list to add and choose the OK button.    (You can also add a distribution list by 
double-clicking on the list name.)
For Windows NT users: Choose the Network... button to connect to another network drive and access other 
distribution list files.

7. To remove names or lists from the distribution list, select the entry to remove and choose the Remove button.
8. Choose the OK button to save the list or choose the Cancel button to exit the dialog box without creating the 

list.
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Modifying a Distribution List

1. From the Gold-Fax File menu, choose Distribution Lists, then choose Modify.
2. Select or enter the name of the distribution list you want to modify.
3. Choose the OK button.    The Gold-Fax: Modify Distribution List dialog box displays:

4. Your default personal phonebook is automatically opened with its entries listed.    To add names to the 
distribution list, use the phonebook selection box to open the personal or system phonebook file that contains
the names you want to add.    Once the desired phonebook is displayed, select the names you want to add to 
the list and choose the RIGHTARROW button.    (You can also add a name by double-clicking on the entry.)
To reference another list within this distribution list, choose the Add List button to display the Gold-Fax: 
Open Distribution Lists dialog box.    Select the desired distribution list and choose the OK button.    (You 
can also add a distribution list by double-clicking on the list name.)
To remove names or list references from the distribution list, select the entry to remove and choose the 
Remove button.

5. Choose the OK button to save the list or choose the Cancel button to exit the dialog box without saving 
changes.
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Deleting a Distribution List

1. From the Gold-Fax File menu, choose Distribution Lists, then choose Delete....    The Gold-Fax: Delete 
Distribution Lists dialog box displays.

2. Select or enter the file name of the distribution list you want to delete.
For Windows NT users: Choose the Network... button to connect to another network drive and access other 
distribution lists.

3. Choose the OK button to delete the selected list or choose the Cancel button to exit the dialog box without 
deleting the list.
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Introduction to Gold-Fax Preferences

Gold-Fax Preferences allow you to specify cover page information, the method for notification of success or 
failure of fax transmissions, and the method for notification of received faxes (if your site is using Gold-Fax 
Receive).    Gold-Fax Preferences also allow you to specify editor and cover page options for sending faxes from 
within the Gold-Fax application.
Default preference values can be set using the Preferences... option on the Gold-Fax File menu.    Preferences can
also be specified or changed for an individual fax message by using the Options... button in the Gold-Fax: Send
Fax dialog box.
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Changing Default Preferences

1. From the Gold-Fax File menu, choose Preferences....    The Gold-Fax: Preferences dialog box displays:

2. Select the appropriate tab to specify preference options as follows:
Mail
Specify which type of mail notification you would like to receive for your sent faxes.
Received
Specify how you would like to be notified when you have received a fax and how often you would like Gold-Fax
to check the server for new received faxes.
Cover Page
Specify which default cover page file you would like to use when sending faxes from other Windows 
applications.    Also specify personal information as you would like it to appear on the cover page.
Message
Specify which default cover page file you would like to use when sending faxes created with the Gold-Fax text 
editor.    Also choose to include your message text on the cover page and specify the fax output line length.
Directories
Specify the directory locations where the Gold-Fax data, storage, and installation files are located.    (See your 
system manager if you are unsure of the Gold-Fax directory locations.)

3. Specify or change the preference items as desired and choose the OK button to save the information.
Choose the Cancel button to exit the dialog box without saving changes.

For more information about these Preference items, select a tab, then choose the Help button for that tab.
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Creating and Sending Faxes

You can create fax messages from Gold-Fax, or you can fax documents and files you have created in other 
Windows applications.
Faxes can include both text and graphics and can be sent to phonebook entries, distribution lists, or to individual 
names that are for the current fax message only.
Fax messages can include both text and graphics.
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Creating a Fax Message from the Gold-Fax Text Editor

You can create fax messages from Gold-Fax using the Gold-Fax text editor.    After choosing the Create a Fax 
Message button on the Main Gold-Fax toolbar, Gold-Fax displays an editor dialog box where you can enter and 
edit text information or open an existing text file for editing.
To create a fax message:
1. Choose the Create a Fax Message button on the Main Gold-Fax toolbar:

or, from the Gold-Fax File menu, choose Create a Fax Message.    The Gold-Fax text editor box displays:

2. Enter your fax message text or choose the Open File button on the Editor toolbar to include an existing text 
file.
Use the following Editor toolbar options to edit your message and save your text file:

3. Once your text message is complete, choose the Send Fax button on the Editor toolbar.    The Gold-Fax: Send
Fax To dialog box will display.

4. Specify fax recipient information and send the fax as described in Specifying Fax Recipients and Sending a 
Fax.
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Including Graphics in a Fax Message

The Gold-Fax text editor supports graphics integration using the @>>GRAPHIC keyword.    Graphics can be 
placed in the message as signatures, titles, logos, etc.    The @>>GRAPHIC keyword directs the substitution of a 
Gold-Fax graphic file (with a .GFI extension) at the location of the keyword in your fax message.    The graphic 
can be placed in a specific location, or it can be centered, right-justified, or left-justified.    Refer to the Gold-Fax 
for Windows NT Manager's Guide for complete instructions on converting graphics for use in Gold-Fax.
Place the graphic in the fax message by entering the following graphic command.    The graphic will begin at the 
indent position where the command is placed:

@>>GRAPHIC="filename.GFI"
The following graphics commands can be used to specify locations for the graphic file:

@>>GRAPHIC="filename.GFI"
,C

Center the graphic between the left and right edges of the page.

@>>GRAPHIC="filename.GFI"
,L

Place the graphic at the left edge of the page.

@>>GRAPHIC="filename.GFI"
,R

Place the graphic at the right edge of the page.
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Creating a Fax Message from Another Windows Application

You can create fax messages from any Windows application.    Fax messages can include both text and graphics.
Fax messages are sent using the same steps you currently use for printing your files and documents.    After you 
select a Gold-Fax printer, Gold-Fax will display dialog boxes where you can enter fax recipient names and other 
information before the fax is sent.
To fax a document or file from your Windows application:
1. Choose Print from your Windows application and select a Gold-Fax printer.    (You may need to use a Print 

Setup command first.)
2. Specify printing options and choose the OK button.    The Gold-Fax: Send Fax To dialog box will display.
3. Specify fax recipient information and send the fax as described in Specifying Fax Recipients and Sending a 

Fax.



Specifying Fax Recipients

After you have chosen the Send Fax button in the Gold-Fax editor or printed your document to a Gold-Fax printer 
from your Windows application, the Gold-Fax: Send Fax To dialog box will display.    From there, you can specify
the names and fax numbers for the people to receive your fax:

You can select fax recipients from phonebooks or you can enter them individually for the current fax transmission
only.    Fax recipients are added to the "Fax Addressees:" list using any of the options described in Sending the 
Fax to Phonebook Entries.
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Sending the Fax to Phonebook Entries

1. Your default personal phonebook (personal.gfp) is automatically opened within the Gold-Fax: Send Fax To 
dialog box, and its entries are displayed for selection.    To select recipients from a different phonebook, open 
the phonebook list box and select either Personal Phonebook... or System Phonebook..., then select the 
desired phonebook.

2. Select names from the open phonebook and choose the RIGHTARROW button.    The selected entries will be 
added to the "Fax Addressees:" box.    (You can also add names by double-clicking on the name.)

3. Once you have specified all of the recipients for this fax, choose the OK button.    The Gold-Fax: Send Fax 
dialog box will display allowing you to specify cover page information and send the fax as described in 
Sending a Fax.
To add a recipient that is not currently listed in a phonebook, see Entering a New Fax Recipient.
To send the fax to a distribution list of names, see Sending the Fax to a Distribution List.
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Sending the Fax to a Distribution List

1. From the Gold-Fax: Send Fax To dialog box, choose the Add List button.    The Gold-Fax: Open 
Distribution Lists displays.

2. Select or enter the distribution list file name and choose the OK button to add the distribution list to the list of
fax addressees.    Choose the Cancel button to exit the dialog box without including the distribution list.

3. Once you have specified all of the recipients for this fax, choose the OK button.    The Gold-Fax: Send Fax 
dialog box will display allowing you to specify cover page information and send the fax as described in 
Sending a Fax.
To add a recipient that is not currently listed in a phonebook, see Entering a New Fax Recipient.
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Entering a New Fax Recipient

1. From the Gold-Fax: Send Fax To dialog box, type the fax number in the "Fax #:" field.    Hyphens, 
parentheses, and slashes can be used to make the number easier for you to read.    Be sure to enter any initial
numbers required by your phone system for accessing outside phone lines or making long distance calls (such
as "9,").    A fax number can contain a maximum of 35 characters.

2. Type the information in the "To:," "Company:," and "Address:" fields as you would like it to appear on the cover
page (if used).

3. Choose the UPARROW (^) button under "Fax Addressees:" to add the entry to the "Fax Addressees:" box.
Note: You can also add this entry to the displayed phonebook by choosing the UPARROW (^...) button next to 
the Personal Phonebook box.    The Gold-Fax: Save Name to Phonebook dialog box displays where you can
enter a name for the phonebook entry:

4. Once you have specified all of the recipients for this fax, choose the OK button.    The Gold-Fax: Send Fax 
dialog box will display allowing you to specify cover page information and send the fax as described in 
Sending a Fax.
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Changing Addressee Information

1. Select an entry from the "Fax Addressees:" list within the Gold-Fax: Send Fax To dialog box.
2. Choose the Examine Addressee button.    The address information will be moved to the fields at the bottom of 

the dialog box.
3. Make the changes as desired.
4. Choose the UPARROW (^) button under "Fax Addressees" to add the new addressee information to the Fax 

Addressees list.    The original addressee information can be removed from the list as described in Removing a
Fax Addressee Entry.



Removing a Fax Addressee Entry

1. Select an entry from the "Fax Addressees:" list within the Gold-Fax: Send Fax To dialog box.
2. Choose the Remove button to remove the entry.



Sending a Fax

After you have specified the fax recipients and chosen the OK button on the Gold-Fax: Send Fax To dialog box, 
the Gold-Fax: Send Fax dialog box displays:

To send the fax:
1. Enter subject lines as you would like them to appear on the cover page.
2. If you need to change the Fax Addressees list, choose the To... button to return to the Gold-Fax: Send Fax To

dialog box and follow the instructions as described in Specifying Fax Recipients.
3. Choose the Options... button if you would like to change or specify different send options for this fax message.

From the Gold-Fax: Send Options dialog box, you can:
· Change the mail notification address and specify your desired mail notification method.
· Specify desired cover page options and the cover page file.
· Include your message text on the fax cover page by selecting "Include on cover page."

(Note: The "Include on cover page" option is only available for faxes created using the Gold-Fax text editor. 
If you select "Include on cover page," you must make sure you have specified a cover page file that 
supports this feature.    If you are sending the fax from another Windows application, your message text will
start on a separate page.)

· Send the fax at a later time by selecting the Send After checkbox.    Enter a time (in the requested format) 
when you would like the fax to be sent.

· Change or add your Personal Name, Phone Number, or Fax Number as you would like them to appear on 
the cover page.



Choose the OK button when you are finished specifying send options.    You will be returned to the Gold-Fax: 
Send Fax dialog box.

4. Choose the Send button to send the fax.

{button ,AL(`Displaying the Sent Fax Status Index;Introduction to Sent Faxes;Resending a Fax;Viewing a Sent 
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Resending a Fax

You can resend sent, failed, or aborted faxes to the original recipient or to new and/or additional recipients.
To resend a fax:
1. From the Sent Fax Status Index, select the fax to resend and choose the Resend button on the Status toolbar:

or, from the Status menu, choose Resend Fax.    The Gold-Fax: Send Fax dialog box will display.
2. Specify fax recipients, subject information, and fax options as described in Specifying Fax Recipients and 

Sending a Fax.



Viewing a Sent Fax

The Gold-Fax Viewer allows you to view your sent faxes as they look to the recipient.    (Note: Depending on your 
site's Gold-Fax setup, viewing of sent faxes may not be supported.)
To view a sent fax:

From the Sent Fax Status index, select the fax to be viewed and choose the View Sent Fax button on the 
Status toolbar:

or, from the Status menu, choose View Sent Fax.    The Gold-Fax Viewer displays the first page of the fax 
similar to the following:
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Introduction to Sent Faxes

A status record is kept for each fax you submit to the Gold-Fax printer.    With Gold-Fax, you can view the fax 
status records on your screen or print them as a report.    You can also stop (abort) submitted faxes, resend faxes,
view sent faxes, and maintain your fax status listing.    Your fax status information will be kept for the period of 
time specified by your system manager.    (Note: Depending on your site’s Gold-Fax setup, viewing of sent faxes 
may not be supported.)
Gold-Fax reports the status based on fax jobs.    A fax job can have messages to one or more fax phone numbers,
plus retry records for any of the numbers.    Each phone number dialed will have a final completion status 
indicating success or failure for that phone number.    Any retry status entries will be grouped under the entry for 
that phone number.
The status index displays on the left side of a split window, with details of the selected status entry displayed on 
the right side.    Clicking on an entry in the status index will display status details for that entry.
The various fax status conditions are represented by the following icons:
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Displaying the Sent Fax Status Index

1. Choose the Sent Fax Status button on the Main Gold-Fax toolbar:

or, from the Gold-Fax File menu, choose Sent Fax Status.    A status index similar to the following displays:

The status index displays on the left side of a split window, with details of the selected status entry displayed 
on the right side.

2. To view completion status records for a fax job, double-click on the desired entry or, from the Status menu, 
choose Open/Close Level.    The display will show individual status information plus any retry attempts for 
each number dialed:
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Printing Status Information

1. Choose the Sent Fax Status button on the Main Gold-Fax toolbar to display your status index:

or, from the Gold-Fax File menu, choose Sent Fax Status.    The status index will display.
2. To print the status index, choose the Print button on the Main Gold-Fax toolbar when one of the entries in the 

status index is highlighted.    To print the detailed status information for the highlighted status entry, position 
the cursor within the status detail screen and choose the Print button on the Main Gold-Fax toolbar:

or, from the Gold-Fax File menu, choose Print Index... or Print Details....
3. Specify print settings and choose the OK button to print the status information.
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Refreshing a Status Index

You can refresh (update) your status index to include the latest status information for your sent faxes.
To refresh your status listing:

From the status index, choose the Refresh button on the Status toolbar:

or, from the Gold-Fax Status menu, choose Refresh.    Updated status information will automatically be 
displayed in your status index.
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Stopping a Fax in Progress

1. Select the pending fax you want to stop from the Sent Fax Status index.
2. Choose the Stop Fax button on the Status toolbar:

or from the Status menu, choose Stop Fax.    The Gold-Fax: Confirm Stop Fax dialog box displays.
3. Choose the Yes button to stop the fax.    The fax will be stopped, and the status for that entry will change to 

"Aborted."



Deleting a Sent Fax Status Entry

Status entries can be deleted at any time from your status index.    If the selected fax has already sent, the entry 
will be marked for deletion and will automatically be deleted from the index when you exit Gold-Fax.    If the 
selected fax is still in progress (pending or sending), you will be prompted to confirm if you want to abort the fax 
transmission before marking the entry for deletion.
To delete an item from your status index:
1. From the Sent Fax Status index, select the entry you want to delete.
2. Choose the Delete From Listing button on the Status toolbar:

or, from the Gold-Fax Status menu, choose Delete From Listing.    The entry will be marked for deletion and will
automatically be deleted when you exit Gold-Fax.

To "undelete" an item marked for deletion, repeat the above steps.
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Resending a Previously Sent Fax

You can resend sent or aborted faxes to the original recipient or to new and/or additional recipients.
To resend a fax:
1. From the Sent Fax Status index, select the fax to be resent and choose the Resend button on the Status 

toolbar:

or, from the Status menu, choose Resend Fax.    The Gold-Fax: Send Fax dialog box will display.
2. Specify fax recipients, subject information, and fax options as described in Specifying Fax Recipients and 

Sending a Fax.
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Introduction to Received Faxes

Gold-Fax Receive allows you to receive and view faxes on your desktop.    If your site is using DID (Direct Inward 
Dial), your faxes will be received directly at your desktop.    If your site is not using DID, faxes received on your 
system will be viewed by a designated router and forwarded to you.    If you have been set up as a router for your
site, see Routing Received Faxes for complete instructions.
An InBox folder is automatically created for you when you install Gold-Fax on your client system, and all faxes 
forwarded to you are received there.    You may also create other folders for storing your received faxes.
If you have selected one of the received fax notification options in your Gold-Fax Preferences, the Gold-Fax: 
Received Faxes dialog box will display when you have received a fax.

See your system manager if you are unsure whether Gold-Fax Receive is installed on your system.
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Viewing a Received Fax

1. When you enter Gold-Fax, the Gold-Fax: Received Faxes dialog box will display if you have unread faxes in 
your InBox.    Choose the InBox button to view your received faxes or choose the Cancel button to cancel the 
dialog box and remain in Gold-Fax.

If you are already running Gold-Fax, you can choose the Received Faxes button on the Main Gold-Fax toolbar 
to return to the Received Faxes listing:

A listing of received faxes will display in a split window similar to the following:

The left side of the window contains your InBox plus any additional folders you may have created.    An InBox 
is automatically created when you install Gold-Fax and is automatically opened when you choose the InBox 
button from the Gold-Fax: Received Faxes dialog box.    All faxes routed to you are received in your InBox.
The right side of the window contains a listing of received faxes for the highlighted folder.    Faxes shown in 
bold are unread.    Faxes left in your InBox may be automatically deleted after a period of time specified by 
your system manager.
You can update the Received Faxes listing to display newly-received faxes by double-clicking on the InBox 
folder.

2. To view a received fax, select the fax and choose the View button on the Received Faxes toolbar:

or, from the Received menu, choose View.    You can also view faxes by double-clicking on the desired fax.    
The first page of the fax displays as in the following example:



The Gold-Fax Viewer provides you with many options for viewing, rotating, scaling, and displaying your received 
faxes.
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Editing Received Fax Information

The Edit Information option is available from the Received Faxes listing and allows you to add "From" and 
"Subject" reference information to help you identify the fax.
To add reference information to a received fax:
1. From the Received Faxes listing, select the fax and choose the Edit Information button on the Received Faxes 

toolbar:

or, from the Received menu, choose Edit Information.    The Gold-Fax: Edit Fax Information dialog box 
displays:

2. Add "From:" and/or "Subject:" reference information as desired.
3. Choose the OK button to save the reference information.



Copying or Moving a Received Fax

You can copy or move received faxes between folders.    With Copy, a copy of the fax remains in the original 
folder; with Move, the fax is deleted from the original folder.
To copy or move a fax:
1. From the Received Faxes listing, select the fax you want to copy or move.
2. Choose the Copy or Move button on the Received Faxes toolbar:

or, from the Gold-Fax Received menu, choose Copy or Move.    The Gold-Fax: Copy to Folder or Gold-Fax: 
Move to Folder dialog box displays:

3. Select the destination folder and choose the OK button, or double-click on the destination folder name to 
complete the copy or move function and close the dialog box.
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Forwarding a Received Fax

Use the Forward command to forward a received fax to another user.
1. From the Received Faxes listing, select the fax you want to forward.
2. Choose the Forward button on the Received Faxes toolbar:

or, from the Received menu, choose Forward.    The Gold-Fax: Forward Fax dialog box displays:

3. Specify users to receive a copy of the fax by selecting names from the list of Gold-Fax Receive users and 
choosing the Add button, or by double-clicking on the name.    You can also add names by entering them in 
the name box above the listing.
Remove a user from the Forward List by selecting the user's name and choosing the Remove button.
Select the "Delete fax from folder after forwarding" box to delete the fax once it is forwarded.

4. When you have specified all of the users you want to receive the fax, choose the OK button to forward the 
fax.    Choose the Cancel button to exit the dialog box without forwarding the fax.
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Forwarding a Received Fax Through Microsoft Mail

If your workstation is set up to use Microsoft Mail, you can mail copies of your faxes to other Microsoft Mail users.
To forward a copy of a received fax through Microsoft Mail:
1. From within the Gold-Fax Viewer, choose the Send Mail button on the Viewer toolbar:

or, from the File menu choose Mail....    The image automatically converts to mail format.
2. If you are not already running Microsoft Mail, the Sign In dialog box will display prompting you for your 

password.    Enter your password name and choose the OK button.
3. Once you are logged in to Microsoft Mail, the Send Note form displays allowing you to enter the desired mail 

recipient information.
Refer to your Microsoft Mail documentation for complete instructions on using Microsoft Mail.
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Deleting a Received Fax

1. From the Received Faxes listing, select the fax to be deleted.
2. Choose the Delete button on the Received Faxes toolbar:

or, from the Received menu, choose Delete.    The Gold-Fax: Confirm Delete Fax dialog box displays.
3. Choose the Yes button to delete the fax, or choose the No button to leave the fax in the folder.



Printing a Received Fax

To print a specific received fax:
1. Select and view the fax with the Gold-Fax Viewer.
2. From the Viewer, choose the Print button on the Viewer toolbar:

or, from the File menu, choose Print.
3. Set print values within the Print dialog box.    Choose the Setup button to select another printer.
4. Choose the OK button to print the fax.

To print a listing of received faxes:
1. From the Received Faxes listing, choose the Print button on the Main Gold-Fax toolbar:

or, from the File menu, choose Print Fax List.
2. Set print values within the Print dialog box.    Choose the Setup button to select another printer.
3. Choose the OK button to print the fax listing.



Automatically Forwarding Received Faxes

You can choose to have your received faxes automatically forwarded upon receipt to another Gold-Fax user.
To automatically forward your faxes to another user:
1. From the Received Faxes listing, choose Auto Forward from the Received menu.    The Gold-Fax: Automatic 

Forwarding dialog box displays:

2. Specify the name of the person to receive your faxes by double-clicking on the name, or by typing the name 
in the "Forward To:" box.
The "Automatically Forward Received Faxes" option will automatically become selected when you enter a 
name in the "Forward To:" box.    Clear the "Automatically Forward Received Faxes" checkbox to disable auto 
forwarding while retaining the selected name in the "Forward To:" box (for future use).    Note that this option 
will be disabled if the "Forward To:" box is blank.

3. Select "Retain copy of forwarded faxes" to keep a copy of your forwarded faxes in your InBox.
4. Choose the OK button to save the Automatic Forwarding settings.



Routing Received Faxes

If your system manager has designated you as a Gold-Fax router, you will be responsible for routing received 
faxes to the proper recipients.
As a Gold-Fax router, you may choose to be notified at regular intervals when faxes are received on your system. 
You can specify notification preferences in your Gold-Fax Preferences.
As a Gold-Fax router, you can view the first page of the received fax (usually a cover page) to determine the 
recipient.    You can then forward the fax to the proper recipient using the methods described in Forwarding 
Unrouted Faxes.
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Forwarding Unrouted Faxes

To view and forward an unrouted fax:
1. Choose the Unrouted button on the Gold-Fax: Received Faxes dialog box:

or, if you are already running Gold-Fax, choose the Received Faxes button on the Main Gold-Fax toolbar:

then select the Unrouted folder to display a list of unrouted faxes:

2. View the fax to be routed by double-clicking on the fax, or by any of the other viewing methods as described 
in Viewing a Received Fax.

3. After determining the recipient, return to the Received Faxes listing by choosing the Return to Gold-Fax button
on the Viewer toolbar:

4. From the Received Faxes listing, choose the Forward button on the Received Faxes toolbar:

and specify forwarding information as described in Forwarding a Received Fax.



Editing Unrouted Faxes

The Edit Information option is available from the Received Faxes listing and allows you to add "From" and 
"Subject" reference information to help you identify the fax.
To add reference information to a received fax:
1. From the Received Faxes listing, select the fax and choose the Edit Information button on the Received Faxes 

toolbar:

or, from the Received menu, choose Edit Information.    The Gold-Fax: Edit Fax Information dialog box 
displays:

2. Add "From:" and/or "Subject:" reference information as desired.
3. Choose the OK button to save the reference information.



Printing Unrouted Faxes

To print a specific unrouted fax:
1. Select and view the fax with the Gold-Fax Viewer.
2. From the Viewer, choose the Print button on the Viewer toolbar:

or, from the File menu, choose Print.
3. Set print values within the Print dialog box.    Choose the Setup button to select another printer.
4. Choose the OK button to print the fax.

To print a listing of unrouted faxes:
1. From the Received Faxes listing, choose the Print button on the Main Gold-Fax toolbar:

or, from the File menu, choose Print Fax List.
2. Set print values within the Print dialog box.    Choose the Setup button to select another printer.
3. Choose the OK button to print the fax listing.



Introduction to Gold-Fax Folders

An InBox folder is automatically created when you install Gold-Fax on your client system, and all faxes forwarded 
to you are received there.    From your Received Faxes listing, you can create additional folders for storing and 
organizing your received faxes.
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Opening a Folder

Select the folder to open and choose the Open Folder button on the Received Faxes toolbar:

or, from the Received menu, choose Open Folder.    The highlighted folder will open with the contents of the 
folder displaying on the right side of the window.    You can also open folders by double-clicking on the folder 
name.



Creating a New Folder

1. With any folder highlighted, choose the New Folder button on the Received Faxes toolbar:

or, from the Received menu, choose New Folder.    The Gold-Fax: New Folder dialog box displays:

2. Specify the Folder Name as you would like it to appear in Gold-Fax.
3. Specify a Folder File Name if you want to use a file name other than the default assigned by Gold-Fax.    The 

default file extension for folder names is ".gff."
4. Choose the Select button to view a listing of currently-used file names or to specify a different directory.
5. Choose the OK button to accept the folder designations and create the new folder, or choose the Cancel 

button to exit the dialog box without creating a new folder.



Deleting a Folder

1. Select the folder to delete and choose the Delete Folder button on the Received Faxes toolbar:

or, from the Received menu, choose Delete Folder.    The Gold-Fax: Confirm Delete Folder dialog box 
displays.

2. Choose the Yes button to delete the folder and its contents, or choose the No button to exit the dialog box 
without deleting the folder.



Finding a Folder

Use the Find Folder option when you want to share Gold-Fax folders with other users.
1. With any folder highlighted, choose the Find Folder button on the Received Faxes toolbar:

or, from the Received menu, choose Find Folder.    The Gold-Fax: Find Folder dialog box displays.
2. Specify the file and directory specifications to search for and choose the OK button.    Choose the Network... 

button to connect to another network drive to access other folders.    Choose the Cancel button to exit the 
dialog box and return to Gold-Fax.



Introduction to the Gold-Fax Viewer

The Gold-Fax Viewer allows you to view sent and received faxes directly on your desktop.    The Gold-Fax Viewer 
provides you with many options for viewing, rotating, scaling, and displaying your faxes.    (Note: Viewing of sent 
faxes is only supported when running Gold-Fax from a Gold-Fax Windows NT server system.)
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Opening the Gold-Fax Viewer

To open the Gold-Fax Viewer from the Sent Fax Status index:
From the Sent Fax Status index, select the fax to view and choose the View Sent Fax button on the Sent Fax 
Status toolbar:

or, from the Status menu, choose View Sent Fax.

To open the Gold-Fax Viewer from the Received Faxes listing:
From the Received Faxes listing, select the fax to be viewed and choose the View button on the Received 
Faxes toolbar:

or, from the Received menu, choose View.

{button ,AL(`Scale Menu Options;The PageBoard;View Menu Options;Viewer Toolbar Options',0,`',`')}    Related 
Topics



Viewer Toolbar Options

The following Viewer toolbar options are available when you are in the Gold-Fax Viewer.    Note that some Viewer 
toolbar options, such as Next Page, Previous Page, and Go To Page may not be available, depending on the 
number of pages in the fax:

Print
Print all pages of the fax you are currently viewing.
Return to Gold-Fax
Return to the Received Faxes listing or the Status Index leaving the Viewer window open.
Fit to Width
Scale the page to fit horizontally within the Viewer window.
Fit to Show Page
Scale the page to fit vertically within the Viewer window.
Zoom Out
Reduce the entire page by 25% each time you choose the button.
Zoom In
Enlarge the entire page by 25% each time you choose the button.
Rotate Left 90°
Rotate the image counterclockwise 90 degrees.
Rotate Right 90°
Rotate the image clockwise 90 degrees.
Go to Page
Display the Go To Page dialog box and specify the page number to view.
Previous Page
View the previous page of the fax.
Next Page
View the next page of the fax.
Send Mail
Send the fax to another user via Microsoft Mail.
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The PageBoard

The PageBoard displays within the Gold-Fax Viewer.    A numbered button represents each page of the fax being 
viewed.    View a specific page by clicking on the desired page number.
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View Menu Options

The View menu offers the following options while in the Gold-Fax Viewer:
Rotate Normal
Return the page to its original viewing position.
Rotate 90 Degrees
Rotate the page 90 degrees to the left.
Rotate 180 Degrees
Rotate the page 180 degrees (upside down).
Rotate 270 Degrees
Rotate the page 270 degrees to the left (90 degrees to the right).
Reverse Image
Display the page in reverse video.
Next Page
View the next page of the fax.
Previous Page
View the previous page of the fax.
Go To Page
Display the Go To Page dialog box and specify the page number to view.
PageBoard
Hide or display the PageBoard.
Toolbar
Hide or display the Viewer toolbar.
Color Panel
Hide or display the Color Panel, which allows adjustment of various color aspects of the page display.
Image Map
Hide or display the Image Map, which adjusts the viewing field of the page.
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Scale Menu Options

The Scale menu offers the following options while in the Gold-Fax Viewer:
Actual Size
View the page at its actual size.
Scale to 50%
Scale the page to 1/2 its actual size.
Scale to 33%
Scale the page to 1/3 its actual size.
Fit to Width
Scale the page to fit horizontally within the Viewer window.
Fit to Show Page
Scale the page to fit vertically within the Viewer window.
Zoom In
Enlarge the entire page by 25%.
Zoom Out
Reduce the entire page by 25%.
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Forwarding Faxes Through Microsoft Mail

If your PC is set up to use Microsoft Mail, you can mail copies of your sent or received faxes to other Microsoft 
Mail users.
To forward a copy of a fax through Microsoft Mail:
1. From within the Gold-Fax Viewer, choose the Send Mail button on the Viewer toolbar:

or, from the File menu choose Mail....    The image automatically converts to mail format.
2. If you are not already running Microsoft Mail, the Sign In dialog box will display prompting you for your 

password.    Enter your password name and choose the OK button.
3. Once you are logged in to Microsoft Mail, the Send Note form displays allowing you to enter the desired mail 

recipient information.
Refer to your Microsoft Mail documentation for complete instructions on using Microsoft Mail.



Returning to Gold-Fax from the Viewer

From within the Gold-Fax Viewer, you can quickly return to the Sent Fax Status index or the Received Faxes 
listing (depending on where you entered the viewer from) by choosing the Return to Gold-Fax button on the 
Viewer toolbar:

The Viewer window will remain open, allowing you to quickly switch between Gold-Fax functions and the Gold-Fax
Viewer.
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Main Gold-Fax Window

From the Main Gold-Fax window, you can create and open phonebooks, maintain distribution lists, display the 
status of attempted fax transmissions, maintain received faxes, change preferences, and exit Gold-Fax.
While in the Main Gold-Fax window, the following Main toolbar buttons are available:

and the menu bar displays the following options:
File 
Window 
Help 



Phonebook Window

The Phonebook window displays names within the open phonebook.    Multiple phonebook windows may be open 
within the Main Gold-Fax window.
While in a Phonebook window, the following Phonebook toolbar buttons are available:

and the menu bar displays the following options:
File 
Name 
Window 
Help 



Sent Fax Status Window

The Sent Fax Status window displays a status index on the left side of a split window, with details of the selected 
status entry displayed on the right side.
The various fax status conditions are represented by the following icons:

While in the Sent Fax Status window, the following Status toolbar buttons are available:

and the menu bar displays the following options:
File 
Status 
Window 
Help 



Received Faxes Window

The Received Faxes window displays the list of available folders on the left side of a split window, with contents 
of the highlighted folder displayed on the right side.
While in the Received Faxes window, the following Receive toolbar buttons are available:

and the menu bar displays the following options:
File 
Received 
Window 
Help 



Viewer Window

The Gold-Fax Viewer window allows you to read (view) faxes and display them in a variety of ways.
While in the Gold-Fax Viewer, the following Viewer toolbar buttons are available:

and the menu bar displays the following options:
File 
Edit 
View 
Scale 
Help 



Message Window
The Gold-Fax Message window allows you to enter and edit your fax message text and open existing files for 
editing.
While in the Gold-Fax Message window, the following Editor toolbar buttons are available:

and the menu bar displays the following options:
File 
Edit 
Message 
Window 
Help 



File Menu

The File menu displays the following options:
Close
Close the currently active window.    This option is grayed (disabled) if there are no open windows.
Create a Fax Message
Create and edit a fax message using the Gold-Fax text editor.
Sent Fax Status
Display status information for submitted fax transmissions (fax jobs).
Received Faxes
Display the Received Faxes listing and fax folders.
Phonebook >
Create or open a personal or system phonebook.
Distribution Lists >
Create, modify, or delete distribution lists.
Preferences...
Specify cover page information, the method for notification of success or failure of fax transmissions, and the method for 
notification of received faxes.
Print...
Print phonebooks when in the Phonebook window.
Print Index...
Print the sent fax index when in the Sent Fax Status window.
Print Details...
Print sent fax status details when in the Sent Fax Status window.
Print Fax List...
Print the open folder's fax list when in the Received Faxes window.
Print Preview
Preview the phonebook file, status listing, or fax list before printing.
Print Setup...
Select printer options from the Print Setup dialog box.



Name Menu

The Name menu displays the following options:
Add
Add names to a selected phonebook.    In a read-only phonebook, the Add option will be disabled.
Edit
Edit names in a selected phonebook.    In a read-only phonebook, the Edit option will be disabled.
View
View names in a selected phonebook.
Delete
Delete names in a selected phonebook.    In a read-only phonebook, the Delete option will be disabled.
Search
Search phonebook entries for specified information.
Copy
Copy names from one phonebook to another while retaining a copy of the name in the original phonebook.
Move
Move names from one phonebook to another while deleting the name from the original phonebook.    In a read-only phonebook, 
the Move option will be disabled.



Message Menu

The Message menu displays the following option:
Send Message
Display the Gold-Fax: Send Fax To dialog box to specify fax recipient information and send the fax message.

{button ,AL(`Creating and Sending Faxes',0,`',`')}    Related Topics



Window Menu

The Window menu displays the following options:
Cascade
Resize and layer the open windows in a cascade fashion, with each title bar visible.
Tile
Resize and arrange the open windows vertically.
Arrange Icons
Distribute icons evenly along the lower edge of the Main Gold-Fax window.
Split
Position the split line on two-pane windows.
Toolbar
Turns the active window's toolbar display on or off.
Status Bar
Turn the Status Bar display (at the bottom of the window) on or off.



Help Menu

The Help menu displays the following options:
Contents
Display contents for Gold-Fax for Windows Help.
Help on the . . . Window
Display Help for the currently active window, or for the Main Gold-Fax window if no other windows are open.    The name of this 
menu item will be the currently active window.
Search for Help on...
Display the Help Topics dialog box to search for Help on a specific topic.
How to use Help
Display instructions for using Help.
About Gold-Fax...
Display the version number of Gold-Fax and the copyright notice.



Received Menu

The Received menu displays the following options:
View
View the selected fax.
Edit Information...
Add "From" and "Subject" reference information to the selected fax.
Copy...
Copy the selected fax or faxes to another folder.
Move...
Move the selected fax or faxes to another folder.
Forward...
Forward the selected fax or faxes to specified users.
Delete...
Delete the selected fax or faxes.
Open Folder
Open the selected fax folder.
New Folder...
Create a new fax folder.
Find Folder...
Find an existing fax folder.
Delete Folder...
Delete the selected fax folder.
Auto Forward...
Set or cancel Automatic Forwarding.

{button ,AL(`Received Faxes Window',0,`',`')}    Related Topics



Edit Menu

The Edit menu displays the following options:
Undo
Undo the last editing function (when in the Gold-Fax text editor).
Cut
Cut the selected text and place in on the clipboard (when in the Gold-Fax text editor).
Copy
Copy the selected text to the Clipboard.
Paste
Paste text from the Clipboard.
Delete
Remove the selected text (when in the Gold-Fax text editor).
Find
Search for specified text within the Gold-Fax text editor.
Find Next
Search for the next occurrence of the specified text.
Replace
Search for and replace specified text within the Gold-Fax text editor.



View Menu

The View menu displays the following options:
Rotate Normal
Return the page to its original viewing position.
Rotate 90 Degrees
Rotate the page 90 degrees to the left.
Rotate 180 Degrees
Rotate the page 180 degrees (upside down).
Rotate 270 Degrees
Rotate the page 270 degrees to the left (90 degrees to the right).
Reverse Image
Display the page in reverse video.
Next Page
View the next page of the fax.
Previous Page
View the previous page of the fax.
Go to Page...
Display the Go To Page dialog box and specify the page number to view.
Page Board
Hide or display the PageBoard.
Toolbar
Hide or display the Viewer toolbar.
Color Panel
Hide or display the Color Panel, which allows you to adjust various color aspects of the page display.
Image Map
Hide or display the Image Map, which allows you to adjust the viewing field of the page.



Scale Menu

The Scale menu displays the following options:
Actual Size
View the page at its actual size.
Scale to 50%
Scale the page to 1/2 its actual size.
Scale to 33%
Scale the page to 1/3 its actual size.
Fit to Width
Scale the page to fit horizontally within the Viewer window.
Fit to Show Page
Scale the page to fit vertically within the Viewer window.
Zoom In
Enlarge the entire page by 25%.
Zoom Out
Reduce the entire page by 25%.



Help Menu

The Help menu displays the following options:
Contents
Display the contents for Gold-Fax Viewer Help.
How to Use Help
Display instructions for using Help.
Image Details
Display file and image details of the fax being viewed.
About Gold-Fax Viewer
Display the version number of the Gold-Fax Viewer and the copyright notice.



Status Menu

The Status menu displays the following options:
Refresh
Update the status display with any new status information.
Open/Close Level
Open further levels of status information for the selected entry.    Disabled if selected entry contains no further levels.
Stop Fax
Stop a selected pending fax from being sent.
Resend Fax
Display the Gold-Fax: Send Fax dialog box where you can specify fax options and resend the fax to the original or to different 
addressees.
Delete From Listing
Mark the selected status entry for deletion upon exiting Gold-Fax.    If the selected fax is still in progress (sending or pending), 
you will be prompted to confirm if you want to abort the fax transmission before marking the entry for deletion.
View Sent Fax
Open the Gold-Fax Viewer and view the selected fax.

{button ,AL(`Displaying the Sent Fax Status Index;Viewing a Sent Fax',0,`',`')}    Related Topics



Server Directory Specification

Specify the server directory where Gold-Fax system files are located.
Gold-Fax Server Directory
Specify the directory on the Gold-Fax Server system where Gold-Fax system phonebooks, cover pages, and fax status files are 
located.
Server Type
Choose the appropriate Gold-Fax server type for your installation.



File Open

Specify the following file information when opening a text file within the Gold-Fax text editor:
File Name
Specify the file name to be opened.    The list box below will display the existing text files in the specified directory.
List Files of Type
Specify the types of files to display.
Directories
Displays the current drive and directory location.    The list box below displays the directories on the current drive.
Drives
Displays the drives available on your system.



File Save As

Specify the following file information when saving your text message to a file:
File Name
Specify the file name for the text message.
Save Files as Type
Specify the types of files to display.
Directories
Displays the current drive and directory location.    Specify the directory to which to save the file.
Drives
Displays the drives available on your system.    Select the drive to which to save the file.



Find Text

Search the message for specific text by specifying the following criteria:
Find What
Specify the search information.    All entries containing the specified characters will be found.
Match Case
Select this check box to search for text with the same capitalization as the text entered in the "Find What" field.
Direction
Specify the direction in which to search for the information.
Find Next
Begin the search or find the next occurrence of the specified search criteria.



Directory Locations
Specify various Gold-Fax directories and server information.
Gold-Fax Server Directory
Specify the directory on the Gold-Fax Server system where Gold-Fax system phonebooks, cover pages, and fax status files are 
located.
Server Type
Specify the appropriate Gold-Fax server type for your installation.
Personal Directory
Specify the directory where your personal phonebooks and distribution lists will be stored.
Installation Directory
Specify the directory where the Gold-Fax program is located.



Distribution List Specification

Specify the following distribution list file information when creating or opening a distribution list:
File Name
Enter the distribution list file name to add, create, modify, or delete.
List Files of Type
Specify the types of files to display in the File Name list box.
Directories
Specify the desired directory.
Drives
Specify the desired drive.



Distribution List Maintenance

Specify the following distribution list file information when creating, deleting, or modifying a distribution list:
Phonebook
This list box displays the contents of the currently selected phonebook.    When the dialog box is entered for the first time, the 
personal phonebook personal.gfp is displayed.
Phonebook Selection Box
To display another phonebook, select either Personal Phonebook... or System Phonebook....    A dialog box will then be displayed
to allow selection of the desired phonebook.
Distribution List
Displays the location and file name of the distribution list, with the list of fax addressees displayed in a box below.
->
Choose this button to copy any selected names in the Phonebook list box to the Distribution List list box.    This button is disabled
if there are no names selected.
Add List
Choose this button to add an entire distribution list.    The Gold-Fax: Open Distribution Lists dialog box will appear to allow you to 
select the desired list to add.
Remove
Choose this button to remove a selected addressee from the Distribution List list box.    This button is disabled if there are no fax 
addressees selected.

{button ,AL(`Creating a Distribution List;Introduction to Gold-Fax Distribution Lists',0,`',`')}    Related Topics



Phonebook Name Specification

Specify the following phonebook file information when creating or opening a phonebook:
File Name
Specify the phonebook file name to be created or opened.    The list box below will display the existing phonebook names in the 
specified directory.
List Files of Type
Specify the types of files to display.
Directories
Displays the current drive and directory location.    The list box below displays the directories on the current drive.
Drives
Displays the drives available on your system.
Read Only
If checked, indicates the selected phonebook file cannot be modified.
Network... (Windows NT users only)
Connect to another network drive and access phonebook files.



Adding a Phonebook Name

Add a name to a Gold-Fax phonebook with the following fields:
Name
The reference name for the phonebook entry, up to 15 characters in length.    Gold-Fax will convert what you type to uppercase.   
The name must begin with a letter, and it cannot contain commas ( , ) or slashes ( / ).
Fax #
The fax phone number for the name.    Include any required prefixes, such as 9.    You may include a comma ( , ) to specify a two-
second wait.
To
The name of the person to receive the fax.    This name should be entered the way you would like it to appear on the cover page.
Company
The company name for the person specified in the "To:" field.
Address
The address of the person or company.
Voice #
The voice phone number for the person specified in the "To:" field.
Comment
Reference information or comments for this entry.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Editing a Phonebook Name

Edit a phonebook name to include the following information:
Name
The name of the entry being edited; this field cannot be edited.    To change the name, choose the Save As... button and save the
entry to a different name.    You can then delete the old entry.
Fax #
The fax phone number for the name.    Include any required prefixes, such as 9.    You may specify a comma ( , ) to indicate a 
two-second wait.
To
The name of the person to receive the fax.
Company
The company name for the person specified in the "To:" field.
Address
The address of the person or company.
Voice #
The voice phone number for the person specified in the "To:" field.
Comment
Reference information or comments for this entry.
Save As...
Save the information under a different name, and go to the Gold-Fax: Save Phonebook Name As dialog box.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Viewing a Phonebook Name

View the following phonebook name information:
Name
The name being viewed.
Fax #
The fax phone number for the name.
To
The name of the person to receive the fax.
Company
The company name for the person specified in the "To:" field.
Address
The address of the person or company.
Voice #
The voice phone number for the person specified in the "To:" field.
Comment
Reference information or comments for this entry.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Save Phonebook Name As

Save a phonebook name with the following information:
Name
The reference name for the phonebook entry.    Gold-Fax will convert what you type to uppercase.    The name is limited to 15 
characters in length, and cannot contain commas ( , ) or slashes ( / ).
Fax #
The fax phone number for the name.
To
The name of the person to receive the fax.
Company
The company name for the person specified in the "To:" field.
Address
The address of the person or company.
Voice #
The voice phone number for the person specified in the "To:" field.
Comment
Reference information or comments for this entry.
Phonebook File
The name of the phonebook file to where the entry will be saved.
Save
Add the entry to the phonebook.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Saving a Name to a Phonebook

Save a name to a phonebook with the following information:
Name
The reference name for this fax number.    Gold-Fax will convert what you type to uppercase.    The name is limited to 15 
characters in length, and cannot contain commas ( , ) or slashes ( / ).
Fax #
The fax phone number for the name.
To
The name of the person to receive the fax.
Company
The company name for the person specified in the "To:" field.
Address
The address of the person or company.
Voice #
The voice phone number for the person specified in the "To:" field.
Comment
Reference information or comments for this entry.
Phonebook File
The name of the phonebook file to where the entry will be saved.
Save
Add the entry to the phonebook.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Copying a Phonebook Name

Copy a phonebook name to another phonebook by specifying the following information:
File Name
Specify the phonebook file name to where the selected name is to be copied.    The list box below displays the existing 
phonebook names in that directory.
List Files of Type
Specify the type of files to display.
Directories
Displays the current drive and directory location.    The list box below displays the directories on the current drive.
Drives
Displays the drives available on your system.
Network... (Windows NT users only)
Connect to another network drive and access other phonebook files.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Moving a Phonebook Name

Move a phonebook name to another phonebook by specifying the following information:
File Name
Specify the phonebook file name to where the selected name is to be moved.    The list box below displays the existing 
phonebook names in that directory.
List Files of Type
Specify the type of files to display.
Directories
Displays the current drive and directory location.    The list box below displays the directories on the current drive.
Drives
Displays the drives available on your system.
Network... (Windows NT users only)
Connect to another network drive and access other phonebook files.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Mail Preferences

Specify your mail notification preferences for your sent faxes using the following options:
Mail Notification Address
Specify the address where notification should be sent upon success or failure of the attempted fax transmission.    Must be a 
valid mail address that is compatible with the Gold-Fax Server software.    See your system manager for more information.
Notify by Mail for Failed Faxes
Select this option to receive a mail message when an attempted fax transmission fails.
Notify by Mail for Successful Faxes
Select this option to receive a mail message when a fax transmission has been sent successfully.

{button ,AL(`Changing Default Preferences',0,`',`')}    Related Topics



Received Preferences

Specify notification method and query interval for your received faxes using the following options:
Notify by Message Box
Select this option to receive notification on-screen when you have received a new fax.
Query Interval (in minutes)
Specify how often Gold-Fax should check the server for new received faxes.

{button ,AL(`Changing Default Preferences',0,`',`')}    Related Topics



Cover Page Preferences

Specify the following cover page preference information to use when sending faxes from other Windows 
applications:
Send with Cover Page
Select this option to include a cover page when sending faxes from other Windows applications.
Cover Page File
Specify the default cover page file to use when sending faxes from other Windows applications.
Personal Name
Specify your name the way you would like it to appear on the cover page.
Phone Number
Specify your voice phone number the way you would like it to appear on the cover page.
Fax Number
Specify your fax phone number the way you would like it to appear on the cover page.
Billing Code
Specify an internal billing code to be added to any long distance number.



Message Preferences

Specify the following message preference information to be used when sending faxes from the Gold-Fax text 
editor:
Send with Cover Page
Select this option to include a cover page with the fax transmission.
Include on Cover Page
Select this option to include the message text on the cover page.    (Note: If you select "Include on Cover Page," you must select 
a cover page file that supports this feature.)
Cover Page File
Specify the fax cover page file to use.
Line Length (in inches)
Specify the text line length as it should print in the fax output.



Directories Preferences

Specify the directory locations where the following Gold-Fax server and files are located:
Gold-Fax Server Directory
The directory on the Gold-Fax Server system where Gold-Fax system phonebooks, cover pages, and fax status files are located.
Personal Directory
The directory where your personal phonebooks and distribution lists are stored.
Installation Directory
The directory where the Gold-Fax program is located.



Searching a Phonebook

Search a phonebook for specific entries by specifying the following search criteria:
Find What
Specify the search information.    All entries containing the specified characters will be found.    Wildcard searches are not 
supported.
Match Case
Select this check box to search for entries with the same capitalization as the text entered in the "Find What" field.    (Only 
available when searching the "To," "Company," and "Address" phonebook fields.)
Phonebook Field
Open this list box to specify the phonebook field to search.
Find Next
Begin the search or find the next entry matching the specified search criteria.
Direction
Specify the direction to search.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Opening a System Phonebook

Open a system phonebook by choosing the phonebook name from the System Phonebooks list and choosing 
the OK button or by double-clicking on the phonebook name to open.

{button ,AL(`Introduction to Gold-Fax Phonebooks',0,`',`')}    Related Topics



Send Fax...

Specify the following send options and send the fax:
To...
Change the fax addressees.
Subject
Enter up to two subject lines to appear on the cover page.    These lines will be word-wrapped.
Send
When you have specified all fax addressees and options, choose this button to send the fax.
Cancel
Cancel the send and exit the dialog box.
Options...
Display the Gold-Fax: Send Options dialog box where you can change fax send options.

{button ,AL(`Send Fax To',0,`',`')}    Related Topics



Send Fax To...

Specify fax addressee information using the following fields and options:
Phonebook
The contents of the currently selected phonebook.
Search
Display the Gold-Fax: Phonebook Search dialog box and search the displayed phonebook for specified entry information.
Fax Addressees
The list of addressees to receive this fax.
->
Copy selected names from the Phonebook list box to the Fax Addressees list box.    This button is disabled if there are no names
selected.
Add List
Add a distribution list to the list of fax addressees.
Remove
Remove the selected fax addressee from the Fax Addressees list box.    This button is disabled if there are no fax addressees 
selected.
Personal Phonebook.../System Phonebook...
Select either Personal Phonebook... or System Phonebook....to display a different phonebook.
^...
Add a manually-entered name to the current phonebook.
^
Add a manually-entered fax addressee to the list of fax addressees.
Examine Addressee
Display the selected fax addressee in the "Fax #," "To:," "Company:," and "Address:" fields below.
Fax #
The fax phone number.    Include any required prefixes, such as 9.    You may specify a comma ( , ) to indicate a two-second wait.
To
The name of the person to receive the fax.
Company
The company name for the person specified in the "To:" field.
Address
The address of the person or company.

{button ,AL(`Send Fax To;Specifying Send Fax Options',0,`',`')}    Related Topics



Specifying Send Fax Options

Specify send options for this fax message only using the following fields:
Mail Notification Address
Specify the address where notification should be sent upon success or failure of the attempted fax transmission.    Must be a 
valid VMSmail address, NT user account name, or Microsoft Mail name.
Notify by Mail for Failed Faxes
Select this option to receive a mail message when an attempted fax transmission fails.
Notify by Mail for Successful Faxes
Select this option to receive a mail message when a fax transmission has sent successfully.
Send with cover page
Select this option to send a cover page with this fax transmission.
Include on cover page
Select this option to include your fax message on the cover page.    This option is only available for faxes created using the Gold-
Fax text editor.    If you are sending the fax from another Windows applications, your message text will start on a separate page.   
If you select "Include on cover page, " you must make sure you have specified a cover page file that supports this feature.
Cover Page File
Specify the cover page file to be used.    (The Send with Cover Page option must also be selected.)
Send After
If this check box is selected, the fax will be sent at the specified date and time.    Enter the date and time in the standard format 
shown.
Personal Name
Specify your personal name as you would like it to appear on the cover page.
Phone Number
Specify your voice phone number as you would like it to appear on the cover page.
Fax Number
Specify your fax phone number as you would like it to appear on the cover page.
OK
Accept the specified options and return to the Gold-Fax: Send Fax dialog box.
Cancel
Exit the dialog box without saving changes.
Help
Obtain Help on the dialog box.

{button ,AL(`Send Fax;Send Fax To',0,`',`')}    Related Topics



Copying and Moving Faxes

Choose the Copy to/Move to button to select the destination folder, then choose the OK button to copy or move 
the selected fax.

{button ,AL(`Received Faxes Window',0,`',`')}    Related Topics



Forwarding a Fax

Specify recipients to receive a copy of a received fax using the following dialog box fields and options:
Name List
Specify users to receive a copy of the fax by selecting names from the list of Gold-Fax users.    You can also add names by 
double-clicking on the name, or by entering a name in the name box.
Delete fax from folder after forwarding
Delete the fax once it is forwarded.
Add
Add the selected name to the Forward List.
Remove
Remove the selected name from the Forward List.
Forward List
The list of names to which the received fax will be forwarded.

{button ,AL(`Received Faxes Window',0,`',`')}    Related Topics



Editing Fax Information

View received information and add "From" and "Subject" reference information to a received fax using the 
following fields:
Received
The date and time the fax was received by Gold-Fax.
Routed
The date and time the fax was routed to you.
Pages
The number of pages the fax contains.
CSID
The Calling Station Identifier of the sender.
File Path
The path and file name of the actual fax image.
Status
The status of the fax.    This line will contain one or more of the following status conditions:

Unread
Indicates the fax has never been read (viewed).
Read
Indicates the fax has been read (viewed).
Received with Errors
Indicates the fax was received with errors.
98 dpi
Indicates the fax was received at 98 dots per inch (dpi) resolution.
196 dpi
Indicates the fax was received at 196 dots per inch (dpi) resolution.
Unrouted
Indicates the fax has not yet been routed.

From
Add "From" reference information to help you identify the fax.    This information will appear as part of the fax identification on the 
fax list, and will also appear on the printed fax listing.
Subject
Add "Subject" reference information to help you identify the fax.    This information will appear as part of the fax identification on 
the fax list, and will also appear on the printed fax listing.

{button ,AL(`Received Faxes Window',0,`',`')}    Related Topics



Creating a New Folder

Create a new folder using the following dialog box options:
Folder Name
Specify the folder name as you would like it to appear in Gold-Fax.
Folder File Name
Specify a folder file name if you want to use a file name other than the default assigned by Gold-Fax.    The default file extension 
for folder names is ".gff."
Select
View a listing of currently-used file names, or specify a different directory.
OK
Accept the information displayed and create a new folder.
Cancel
Exit the dialog box without creating a new folder.
Help
Obtain Help on the dialog box.

{button ,AL(`Received Faxes Window',0,`',`')}    Related Topics



Finding a Folder

Search for a fax folder by specifying the following file information:
File Name
Specify a descriptive file name.
List Files of Type
Specify the types of files to display in the File Name list box.
Drives
Displays the drives available on your system.
Network... (Windows NT users only)
Connect to another network drive and access other folders.
OK
Find and add the folder as specified.
Cancel
Exit the dialog box without adding the found folder.
Help
Obtain Help on this dialog box.

{button ,AL(`Received Faxes Window',0,`',`')}    Related Topics



Auto Forwarding Faxes

Specify the following options to have your received faxes automatically forwarded to another user:
Automatically Forward Received Faxes
This check box will automatically become selected when a name is entered in the "Forward To:" box.    Click on this box to 
disable auto forwarding while retaining the selected name (for future use).
Forward to
Specify the name of the person to receive your faxes by double-clicking on the name, or by typing the name in the "Forward To:" 
box.
Retain copy of forwarded faxes
Select this option to keep a copy of the forwarded faxes in your InBox.

{button ,AL(`Received Faxes Window',0,`',`')}    Related Topics




